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Tutorials for Introducing ArcGIS into Introductory Geoscience Courses 
 
Authors: Barbara and David Tewksbury 
Institution: Hamilton College 
e-mail: btewksbu@hamilton.edu; dtewksbu@hamilton.edu 
 
Brief Description: This set of three sequential modular exercises first introduces geoscience students to the 
power of GIS and then gives them experience with the kinds of GIS raster image analysis tasks commonly 
used by geoscientists. 
 
Context: These exercises are part of a GIS Across the Curriculum effort in the Geology Department at 
Hamilton College. We use these core exercises in most of our introductory geoscience courses, and we also 
use them as refresher tutorials and introductory workshops for students in our upper level courses. 
Completion of the first three exercises is considered a base level of GIS knowledge for students entering 
the core courses for the major. 
 
Prerequisite skills: None. 
 
Where situated in the course: Because these GIS modules are not content-specific, they can be used at 
any point in the semester.  
 
Concept goals: Students will become familiar with a suite of GIS tasks that they will use in other GIS 
assignments. These include working with DEMs and DRGs, creating and working with hillshades, 3D 
scenes in ArcScene, and shape files (point, line and polygon), and creating and managing attribute tables. 
Datums, coordinate systems and file management are addressed as well. 
 
Higher order thinking skills goals: Rather than teaching students point-and-click GIS, or techniques 
without analysis, these exercises teach GIS in the context of solving a geoscience problem or addressing a 
geoscience question.  
 
Description: The following three sequential tutorial exercises provide students with an introduction to and 
experience with GIS analysis of raster image data sets. 
Mt. St. Helens exercise: Modified from an ESRI Canada activity, this exercise is designed primarily to be a 
“hook”. It quickly gets students into ArcMap and gives them a first hand experience in the power of 
ArcGIS without bogging them down in background details.  
Clinton exercise: Students gain experience in using ArcCatalog, creating hillshades  of DEMs, and working 
with orthoquads. Although this exercise is built around the Clinton, NY 7.5’ quad, it could be easily 
modified for any other quadrangle.  
Adirondacks exercise: Students practice skills that they have learned in previous tutorials and gain 
experience in working with shape files. The primary emphasis of the exercise is to analyze the correlation 
between topography and bedrock geology in the Adirondacks region. The tutorial also teaches students how 
to create a finished map view. Although the exercise is built around the Adirondack region, it could be 
easily modified for any other area where bedrock resistance is correlated with topography.  
All three tutorials are contained in the assignment/activity document that can be downloaded below. The 
data sets can be individually downloaded below; even though the data sets are in zipped folders, they are 
still large and may take awhile to download). 
 
Evaluation: These tutorials do not have any accompanying assessment. Students are ultimately assessed in 
later activities and assignments on the basis of whether they can apply what they have learned in the 
tutorials to new assignments. 
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NOTE: Occasional blank pages are deliberate and allow the document to be printed double-sided and still 
have the first page of each tutorial start on an odd-numbered page. 
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Exploring ArcGIS: Mt. St. Helens Volcano1 
 

Launching ArcGIS, opening an ArcMap 

• Go to Start and click on All Programs. Click ArcGIS, and select ArcMap. 

• In the dialog box, select An existing map, and click on Browse to maps. 

• Navigate to the Academic Software Server, expand the Geology folder, expand the folder for 

your geo course (GeoscXXX ), expand the folder with your user name, expand the 

Mt_St_Helens folder. Select the file st_helens.mxd. 

• You will now see an ArcMap window with two portions, the map window on the right and the 

Table of Contents (TOC) on the left. Both are blank, because you haven't added any data yet. 

 

Adding data to your ArcMap 

• You now need to tell ArcMap what data you want it to plot on your map.  

• Click on the add data icon (yellow diamond with a plus sign), and, in the Add Data dialog box, 

navigate to the Mt_St_Helens folder. Shift-click to select both hafter and hbefore, and click Add. 

• You'll now see hafter and hbefore under Layers in the TOC and a view of one of the data layers 

in the map window. 

 

Adding the 3D Analyst and Spatial Analyst Extensions and making the toolbars 
visible 

• Go to the Tools menus, and select Extensions. 3D Analyst and Spatial Analyst must be turned on. 

If the two boxes are not checked, check them both. If they are checked, leave them checked. Click 

Close. 

• We now need to make the 3D Analyst and Spatial Analyst toolbars active. In the View menu, 

scroll down to Toolbars and select 3D Analyst. The 3D analyst toolbar will appear as a floating 

toolbar that can be repositioned by clicking in the blue bar and dragging the toolbar around. 

Repeat for the Spatial Analyst toolbar.  

• Toolbars can be docked out of the way by clicking in the blue bar and dragging the toolbar to the 

gray area above the main white map window. Dock both toolbars to get them out of the way. 

 

Deleting a layer if you screw up 

• If you need to get rid of a layer, right click on the layer name in the Table of Contents (TOC), and 

choose Remove. This does not delete the original data file from the folder where it is stored. 

It simply removes it from your map. ArcGIS has a storage system that is like a filing cabinet. 

When you add a map layer to an ArcMap, it's like going to the filing cabinet and pulling out a 

copy of a map to look at. When you remove a layer from your ArcMap, it's like putting the copy 

of the map back into your filing cabinet, not like throwing it away.  

 

                                                
1 This exercise was modified from one developed by ESRI Canada and posted at 
 http://www.esricanada.com/english/5722.asp  
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Managing the data layers 

• To hide and show layers: Next to each layer name in the TOC, you'll see a box with a check 

mark. Clicking in that box allows you to toggle the visibility of a layer. Toggle the top layer on 

and off to show the layer underneath. 

• Rearranging the order of layers: If you decide that you want to have the layers in a different 

order, simply click and hold on the name of the layer and drag it above or below any other layer in 

order to switch its position. Remember that the check box must be checked in order for you to 

actually see a layer, regardless of its position. 

• Before going on, be sure that hbefore is at the top of the list, and make sure that both layers have 

check marks in the TOC. 

 

You have just added two data layers that don't look like much. Let's do something to make the data easier 

to visualize. 

 

Making a hillshade of your data layers 

• Check to be sure that your Spatial Analyst toolbar is visible. If it isn't, repeat the instructions on 

the previous page under Making the 3D Analyst and Spatial Analyst toolbars visible. 

• Click on the word Spatial Analyst in the toolbar, select Surface Analysis, and then Hillshade. In 

the Hillshade dialog box, choose hbefore from the Input Surface pulldown, and leave all but the 

last setting at the default values (315, 45, no model shadows, 1, 30). Click the folder icon next to 

the Output raster box, and navigate to your Mt_St_Helens folder. Call this new file  hshbefore 

(for hillshade before). Make sure that there are NO SPACES in the name when you type it!! 

Click OK, and be patient while ArcMap does the calculation. Be sure to save. 

• Ooooh – wow!! This is what Mt. St. Helens looked like before the eruption of 1981. 

• In the TOC, you'll see your new layer (with the name you called the file) appear at the top of the 

list. You'll also see the map view of your layer, this time as a shaded relief image. You can toggle 

this layer on and off, and you can move it around just like you did with the other layers. 

• Create a hillshade for hafter as well, basing the new hillshade on hafter and naming the new file 

hshafter. Again, don't put any spaces in the name. Be sure to save!! This is what Mt. St. Helens 

looked like after the eruption of 1981. 

 

Toggle the top hillshade on off so that you can see the before and after view of Mt. St. Helens? What 

happened to the mountain as a result of the eruption in 1981? 

 

 

 

Viewing your hillshade in 3D 

• The extension 3D Analyst allows us to view a hillshade in 3D and rotate the 3D view. 

• Check to be sure that your 3D Analyst toolbar is visible. If it isn't, repeat the instructions on the 

previous page under Making the 3D Analyst and Spatial Analyst toolbars visible. 
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• Locate the ArcScene icon in the 3D Analyst toolbar. It's the one second from the right hand end of 

the toolbar and looks like a circle with two yellow Post-Its (if you hold the cursor over an icon 

without clicking, a box will appear telling you what the icon does – if you have the right one, the 

box will say ArcScene). 

• Click the ArcScene icon, which launches ArcScene and brings up a new window that has 

elements that look a lot like ArcMap except that the TOC is headed by the words Scene layers, 

and the menu bar is a bit different. 

• Use the Add Data icon to add your two hillshades from the Mt_St-Helens folder. Remember that 

you can shift-click to add both at once. 

• Save your new ArcScene to your data folder. 

• Locate the icon in the ArcScene toolbar that looks like a globe with four arrows.  This is the 

Navigate icon. Click on it. The cursor will now look like the Navigate icon, and clicking and 

dragging the cursor across the map window will tilt and rotate the hillshade that you've added. 

Right-clicking and dragging will let you zoom the image in and out. The center wheel of the 

mouse also zooms the image in the map window. 

• You can rearrange the two hillshade layers or toggle them on and off. Notice that whatever tilts 

and rotations you do to one layer automatically happens to the other layer as well. 

• Notice, though, that you only have the illusion of 3D. Although the hillshade makes it look 3D, the 

scene is a flat sheet when you rotate it to look at it edge on. So, we need to extrude each pixel 

according to its real elevation. 

• Return the scene to the original orientation by clicking on the globe in the toolbar. 

• Right click on a layer name in the TOC, and select Properties. Choose the Base Heights tab, and 

click the radio button next to Obtain heights for layer from surface. You want ArcScene to get 

the elevations from your original DEM, so you a have to direct ArcScene to find the right file that 

has the original elevations for your hillshade. Click the folder icon, and navigate to the original 

raster image data file (hafter, if you have chosen the after hillshade, or hbefore if you have 

chosen the before hillshade). Click Add. Don't change the other defaults, and click OK. 

• Now, get the Navigate tool from the toolbar, and tilt and rotate. You can even view it from 

below!! If you do both layers, you can toggle before and after eruption to see the effects. Just be 

sure that you obtain the heights from the correct original data layers, not from one of the 

hillshade layers in your own data folder. 

• If you want to increase the vertical exaggeration, right click on Scene Layers at the top of the 

TOC (not on one of your individual layers). Choose Scene Properties, and click the General tab. 

Under vertical exaggeration, choose something other than None. Click OK. If the scene disappears 

from view, you've chosen a vertical exaggeration that is too great. If that happens, go back and 

select a vertical exaggeration of 1.5 or 2. If the vertical exaggeration creeps you out, repeat the 

process, and change it back to None. 

• Quit ArcScene. 
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Back to ArcMap 

The data that you originally added to your ArcMap is a set of digital elevation data called a Digital  

Elevation Model (or DEM for short). Let's explore the data for a minute. 

 

• Turn off the hillshade layers so that only the original hafter and hbefore layers are showing. 

• Use the magnifier tool to zoom in on the map until you can see individual squares. Each square is 

called a pixel (short for "picture element" – a digital image is made up a collection of picture 

elements). The data for this layer includes the geographic location for each pixel, plus its 

elevation. The shade of gray of the pixel reflects its elevation, with darker pixels having lower 

elevations than lighter pixels. 

 

ArcMap then electronically manipulates the pixels so that you see the data in different ways. When you 

asked ArcGIS to hillshade the data, it placed each pixel at its proper elevation, illuminated the scene with 

an artificial Sun, and showed you which pixels would be brightly lit because they are on slopes that face the 

Sun and which would be in the shadows because they are on slopes that face away from the Sun. This gives 

the illusion of 3D because your brain is used to seeing 3D objects with shadows. ArcScene, on the other 

hand, actually allowed you to extrude each pixel to its appropriate elevation so that the image had shape. 

Pretty marvelous program, huh? 

 

The kind of data behind a DEM is called raster data. In raster data, information is stored for every pixel in 

the area of interest. Resolution is governed by the size of each pixel footprint. If each pixel represents the 

average elevation of a 10 m x 10 m square, the resolution of the image (ability to see fine detail) is better 

than if each pixel represents the average elevation of a 1 km x 1 km square. As resolution goes up for a 

given area, so does file size, because the number of pixels increases. 

 

Let's explore the issue of spatial resolution.  

 

• Add one more data layer, lidar_dem, to your ArcMap.  

• Be sure that the two hillshades that you created are turned off.  

• Zoom in on the LIDAR data layer until you can just begin to see individual pixels. 

• Now we'll use a slick ArcMap trick to compare layers. Go to the main menu bar and select View, 

Toolbars, and Effects. You'll have a new toolbar with a layer pulldown plus some icons. Choose 

your LIDAR layer in the pulldown, and then click on the icon that has a horizontal line with a 

down arrow. This is the Sweep tool. 

• Click the mouse on the image, and wait until the hour glass disappears. Click on the LIDAR 

image, and slide the sweep tool from side to side or from top to bottom, revealing the original 

DEM layer beneath the LIDAR layer. What difference do you see between the two DEMs? 

• The resolution of your original DEM layers is 30 m/pixel. In other words, the elevations over a 

square 30 m by 30 m on the ground were averaged to one elevation value. The LIDAR data has a 

spatial resolution of 2 m/pixel! 

• Let's see what a difference this makes in what we can see in a hillshade. 
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• Last, add one more data layer (lidar_hlsd). This is a hillshade of the LIDAR DEM data. Zoom in 

and see what kind of detail you can see! Remember that this is not an aerial photograph – this 

is simply elevation data!! 

• Turn your two other hillshades back on, and turn off the LIDAR data layer (leaving the LIDAR 

hillshade on). Use the swipe tool to compare the LIDAR resolution with the other DEM 

resolution. If it's not working, check to make sure that the layers are in the right order and that that 

you've selected the correct layer in the pulldown. You can zoom in and swipe as well. 
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Nuts and bolts of using ArcGIS and ArcCatalog 
Clinton Quadrangle Exercise 

 
In the first part of this exercise, you explored ArcGIS using a ready-made ArcMap file stored in your own 

folder on the server. In the second part of this exercise, you'll learn how to manage data files (create new 

files, copy files, etc), get more practice in adding data layers and creating cool views, and working with 

topographic map layers. 

 

ArcGIS consists of two parts, ArcMap, which you have already used to create maps, and ArcCatalog, 

which is the way that ArcGIS let's you see the organization and storage for data files and the maps that you 

create. 

 

Launching ArcCatalog 

• Go to Start and click on All Programs. Click ArcGIS, and select ArcCatalog. 

• Much like ArcMap, ArcCatalog has a window divided into two parts, with a Table of Contents 

(TOC) on the left. 

• The Table of Contents (TOC) shows you the organization of folders and files and allows you to 

copy, paste, rename, and remove files (see sections below). 

 

Creating a folder for your data and maps on the C:\ drive 

• For every project the you do, you should create a new folder to organize all of the data and map 

files that you will create. If you don't do this, you will rapidly have long lists of files that are 

difficult to organize after the fact. 

• Although you will get data from the Academic Software Server and copy your work folder to the 

server at the end of a work session, you should do your work on files that are located on the C 

drive, otherwise processing times can be glacially slow. 

• In the left hand window (the ArcCatalog TOC), click on the C:\ drive listing to highlight it. Go 

the main menu bar and click on File, New, and Folder. You'll now see a new folder on the C:\ 

drive.  

• Right click on the new folder, and select Rename. In the file list, change the name to Clinton. This 

name is short, with no spaces. Remember that ArcGIS is very picky about file names. The name 

must be short, and you must be absolutely certain that there are NO SPACES in any name that 

you use for files and folders, and there are no oddball characters. If you want a space in the 

name, you must put in an underscore, not a space. MAC USERS BEWARE. Spaces are OK in 

Mac file and folder names. They are not OK in ArcGIS. If you have trouble getting something to 

work in ArcGIS, the very first troubleshooting thing you should do is check all of your file/folder 

names to make sure that they have no spaces and no long names. 

• When working ArcGIS, it is crucially important to set up new folders that are not in the 

Documents and Settings folder and that have no spaces in the names into which you can save 

your files. In Windows Explorer, the default location for saving files is a folder titled Documents 

and Settings, which, unfortunately, has spaces in the name. Even if you are careful to eliminate 
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spaces in your file names, saving to the default folder means that you are dead in the water. Make 

your own new folder where you can save your work. 

• And, don't make a folder on the Desktop – ArcGIS does not like folders or files on the desktop. 

 

Getting data for this exercise and copying it into your folder 
• Be sure that you have ArcCatalog open. You will need to navigate to the Academic Software 

Server in order to get the data you need for this exercise.  

• Scroll toward the bottom of the  TOC, and check to see whether the Academic Software Server 

already appears in the list. If so, skip to the next step.  

o If the Academic Software Server isn't listed, click on the "connect to folder" icon (the one 

with the horizontal yellow arrow).  

o In the dialog box that comes up, replace the words My Computer with 

\\software\academic\geology\. Be sure to use back slashes, rather than forward slashes. 

Click OK. 

• In the ArcCatalog Table of Contents column at left, expand \\software\academic\geology\, and 

choose the folder for your Geo course. 

• Expand the Geosc_Data folder. This is the place where you will find all of the GIS data and files 

for this course. 

• Right click on the Clinton folder, and select Copy.  

• Expand the C:\ drive in the TOC. Right click on your new data folder, and select Paste. You 

should now have a folder inside your own folder on the C:\ drive that is titled Clinton. 

 

Preview data 

• Be sure that ArcCatalog is open. 

• In the TOC window, expand your folder on the C: drive. Expand the Clinton folder, and 

Clinton_Data. Inside Clinton_Data, and you'll find two folders, Clinton DEM and Clinton 

DOQ. 

• Highlight the Clinton DEM in the TOC window by clicking once on the name. Click on the 

Preview tab in the right hand window. If a dialog box comes up asking whether you want to create 

pyramids, say yes, and wait while pyramids are created. 

• Make sure that the pulldown menu at the bottom is set to Geography. In the Preview window, you 

will see a preview of what the DEM looks like, although you won't be able to do anything with it. 

Then preview the o43075a4.tif file in the Clinton DOQ folder.  This is a digital version of the 

Clinton topographic quadrangle map.  

• To see the digital orthoquad better, select the magnifier from the toolbar, and enlarge the view by 

either repeatedly clicking or by dragging a rectangle of what you want to see. Then select the 

hand tool and drag the image around to see other parts. To return to the full-frame view, just click 

on the globe to the right of the hand. 
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Creating a new ArcMap file and adding the Clinton DEM 

• Launch ArcMap from ArcCatalog by clicking on the globe in the tool bar immediately to the left 

of the red toolbox. OK a new empty map. Toggle the window expansion so that the ArcMap 

window fills the screen. 

• *****Saving Relative Pathways in ArcMap. Before saving an ArcMap .mxd file to your folder, 

make sure that you will be saving relative, rather than absolute, path names. Go to File, Document 

Properties, Data Source Options, and select "Make relative pathways the default for new map 

documents that I create." *****This is absolutely crucial. When you start a new session in the 
GIS lab, you should always check this in case the computer you are working at has been 
reimaged or in case someone has changed the default.  

• Save your map file. Select Save from the File menu. Navigate to the C:\ drive, and select your 

data folder. Name your new map clintonmap. NO SPACES!!! ArcMap will automatically add the 

suffix .mxd when you click Save. 

• Add the Clinton DEM that you previewed in the previous step. 

 

Coordinate systems and projections 
Translating a curved surface to a planar (flat) view results in distortions. Different coordinate systems and 

projections have been developed to minimize these distortions.  

 

When you bring a data set into an ArcMap document, the map document takes on the coordinate system 

and projection of the first data set added to the map (assuming that the data set has a defined coordinate 

system and projection). The map will retain this coordinate system and projection even if you delete all the 

layers you have added to a map.  

• Now that you've added the Clinton DEM to your ArcMap, let's check the coordinate system and 

projection that you're working in.  

• Right click on the word Layers at the top of the ArcMap TOC, and select Properties. choose the 

Coordinate Systems tab, and write down the coordinate system and projection (e.g, 

NAD_1927_UTM_Zone_18N). 

 

Renaming the Data Frame with the projection name 

• It's a good idea to get into the habit of renaming the Data Frame with the coordinate system and 

projection name so that you don't lose track of what the coordinate system and projection in which 

you are working. 

• Click on the word Layers at the top of the TOC to highlight it. Click again, and change the name., 

typing in the projection as the Data Frame name (e.g., NAD_1927_UTM_10N). 

 

Renaming a layer 

• If your layer names are a bit cryptic, you can rename any layer by highlighting the layer name, 

clicking again (not a fast double-click), and typing in a new name.  

• You can also do this by bringing up Layer Properties (either by double-clicking on the layer 

name in the TOC or by right-clicking on the layer name and selecting Layer Properties. Click the 
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General tab, and type a new name in the layer name box, and click OK. TOC layer names (and 

legend items) are about the only things in ArcGIS that are OK with spaces in the names. 

• Just as deleting a layer doesn't delete the original data file, renaming the layer doesn't change the 

name of the original data file in ArcCatalog. If you rename something and can't remember what 

the file was originally, just double-click on the new layer name to bring up the Layer Properties 

dialog box (or right-click and select Layer Properties), and click the Source tab. Under Data 

Source, you'll see the location and name of the file that your layer is made from. 

 

Changing the display coordinate system to lat/lon 

• Move the cursor around in the map window, and watch the numbers changing in the lower right 

hand corner of the map window. These numbers give the exact location on the surface of the Earth 

of the tip of the cursor. The default coordinate system isn't easy for us to visualize, so we'll switch 

it to the familiar latitude and longitude coordinate system. 

• Right click on the word Layers in the TOC, and select Properties to open the Data Frame 

Properties window. Click on the General tab, and, under Units/Display, select Degrees Minutes 

Seconds. Click OK.  

• Moving the cursor over the map will now give coordinates in degrees, minutes, and seconds, with 

longitude first. 

 

DEMs (such as the ones you worked with for Mt. St. Helens) do not have geographic or cultural 

information, and, unless you are really familiar with an area, you may not recognize individual geographic 

features just by looking at the DEM. We can combine a DEM with other kinds of map data to create a 

composite map with different layers contributing various components to the final map. What we'll do next 

is to take a DEM from the Clinton, NY quad and combine it with what's known as a digital orthoquad – a 

digital version of the standard USGS topographic map. The composite map, with variably transparent 

layers, will let us locate geographic features while still being able to visualize the three dimensional shape 

of the land surface. Combining the DEM with a quadrangle map is made possible because the data files are 

georeferenced. In other words, there is information in the files (the metadata) that can tell ArcMap exactly 

where in the world the map is, what its scale is, and what technique was used to project that portion of the 

Earth's sphere to a flat map surface. If any of these pieces is missing, or if the projection method of the 

DEM doesn't match the projection method of the orthquad, you can't combine the maps successfully. This 

is not a trivial issue. We have Dave Tewksbury to thank for all the work he did to make sure that these files 

would work for us in this exercise. 

 

Superimposed topo features on a DEM hillshade 

• Add the Clinton orthoquad. For the orthoquad, be sure to select the raster file in the list (the one 

with the raster file icon and the .tif extension). Rename the orthoquad layer as Clinton 

orthoquad. Save. 

• Add the Spatial Analyst extension, and make the toolbar visible. 

• Make a hillshade from the DEM layer (**remember to select the Clinton_DEM as the Input 

Surface!!!). Be sure to save the hillshade to your data folder in the Clinton example. Again, 
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you'll need to navigate, because the default folder that will likely come up will be your data folder 

for the Mt. St. Helens example. 

• You'll  now see the hillshade layer in the TOC. Rename it, if you like. 

• Re-order the layers in the TOC so that the Clinton orthoquad is the top layer (click, drag, and 

drop). 

• An orthoquad is a raster image. Zoom in until you can see individual pixels in your orthoquad 

layer. Because this is a raster file, ArcMap knows what color every pixel is in the file, and we can 

selectively replace pixels of a particular color with a new color or, as we will do in this exercise, 

with no color, in order to make the pixel transparent. 

• The first thing we'll do is make the white background of the map disappear. Zoom out using the 

globe tool. Expand the Clinton orthoquad layer by clicking on the plus sign next to the layer name. 

Right click in color box #1, and select No color. Zoom in, and admire how you can now see a 

whole lot of the hillshade below. But, there are still some patches we'd like to get rid of, while still 

keeping some of the geographic features on the map. 

• Remember if you screw up, you can always remove the layer and add it again from the 

Clinton data file folder. 

• Do the same for color boxes 5, 6, 7, 9, 10, and 11. Don't do 4, 8, and 12!!! This will turn off all of 

the aspects of the map that are colored any other color except brown (topo lines), red (roads), blue 

(water), and black (labels, buildings, etc.). Use the magnifier tool (you can dock the floating tool 

bar, if you want) to browse around and check out how beautifully the streams lie in the bottoms of 

the valleys on the DEM and how beautifully the steep slopes correspond with the closely-spaced 

topo lines! Check out the College, and find Root Glen on the DEM. Ditto Kirkland Glen. 

 

Proving to yourself that the orthoquad is in the right place 

• Did ArcMap put the digital orthoquad in the right place geographically? You can easily check this. 

Zoom in on the lower right hand corner of the image until you can read the lat/lon coordinates on 

the digital orthoquad. Position the cursor so that it lies right at the corner of the quad, and check to 

see if the lat lon value for the cursor (shown in the information box at lower right) matches the 

values printed on the map. They should!! 

 

Adding character by colorizing your hillshade 

• Make sure that the order of layers in the TOC is, from top to bottom, Clinton orthoquad, hillshade, 

and Clinton DEM. If that's not the order you have, rearrange by dragging and dropping. 

• Go to the orthoquad layer and get rid of the brown topo lines by selecting no color for colors 4 

and 12 (right click on the color box, and select no color). 

• Right click the hillshade layer, and scroll down to Properties. Click the Display tab, and change 

transparency to 50% by typing in 50. Do NOT click OK. Drag the properties window partly out 

of the way so that you can see most of the map. Click apply, rather than OK. This allows you to 

try out various transparencies before committing yourself. You can also play with contrast and 

brightness – try a contrast of 30 and a brightness of 5 for starters. Once you have what you like, 
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and can see the DEM through the hillshade, click OK. You can always go back and change this 

later, if you change your mind as you go along. 

• This is a better image, but it's still a little blah. Let's colorize it! 

• Right click on the Clinton DEM, and select Properties. Click on the Symbology tab. Make sure 

that Stretched is highlighted in the left column, and right-click on the black-to-white color bar. 

Select Graphic View to uncheck it, and the color ramp should now have text instead of a color 

gradation in it.  

• Scroll down to Elevation #1, and select it. Set the Stretch type to None. 

• Click apply, and drag the Layer Properties window out of the way to see what you've done. 

Wowee! You can check out other color ramps as well. When you have what you like, click OK, 

and save. 

• To see what the DEM looks like all by itself, you can turn off the hillshade. If you do this, you'll 

see why both the hillshade and the colorized DEM are necessary for the full 3D effect. 

• Your map may look a little faded with the transparency of the hillshade set to 30%. That's because 

you're looking through a hillshade that is only 30% transparent. You can adjust the transparency of 

the hillshade so that you can see more of the color of the DEM through it.  

• Zoom in and pan around the Clinton area!! 

 
One more super-fun thing to try: creating a 3D topo map and viewing it in 3D 
 

• Start a new ArcMap document. 

• Add the Clinton digital orthoquad (DOQ) and the Clinton DEM. 

• Hillshade the DEM. With the hillshade above the DOQ in the TOC, adjust the transparency of the 

hillshade by right clicking on the hillshade layer in the TOC, selecting Properties, and then the 

Display tab. 

• Enter contrast 30, brightness 5, transparency 50. Be sure that the display quality slider is set to 

Normal. Click Apply. You can experiment with contrast, brightness and transparency if you want 

to before clicking OK. 

• This is how shaded relief maps like you see in National Geographic are made. The key to making 

them is to be sure that the hillshade is the top layer. 

• To look at the map  in 3D, go to ArcScene as before. Add the Clinton DOQ, and right click on the 

DOQ, select Properties, and the Base heights tab. 

• Click the radio button next to Obtain base heights from.., and browse to the Clinton DEM (not 

one of the hillshades), and select it. Click OK. 

• Right click on the DOQ layer, and open Properties. Click on the Rendering tab. Under the 

Effects box, check "Shade areal features relative to the scene's light position". Under Optimize, 

drag the Quality Enhancement Slider to high. Click OK. 

• The screen re-draw will take a few minutes, because it is rendering a nice, less pixelated version. 

You should now have a smooth map but without much appearance of relief. 

• Right click the Scene Layers at the top of the TOC, go to Properties, and select the General tab. 

In the vertical exaggeration, highlight the zero in the box, and type in 2.5. Click OK. 

• You'll now have a 3D topo map that you can view from multiple angles. 
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• For extra super fun, right click on Scene Layers, select Properties, and select the Illumination 

tab. Drag the dialog box to the upper left corner so that you can see your scene. Drag the contrast 

slider to 100%. Click on the Sun in the Azimuth Box, and drag the Sun around the compass rose 

and watch how the illumination in your scene changes. Oooooooh! 

• This is a technique that people use to highlight features that would never be shaded that way in the 

natural world. 
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Adirondack Geology Exercise 
DEMs and Geologic Maps  

 
DEMs can be made in a variety of ways. Elevation data can be digitized from existing topographic maps, 

with elevations interpolated between contour lines. That's how the DEM was created for the Clinton 

exercise that we just did. In the Adirondack exercise that we're about to do, the DEM was created from 

surface elevation data measured from space by the Shuttle Radar Topography Mission (SRTM).  

 

The SRTM data base is a remarkable worldwide digital elevation data set for about 80% of the Earth's land 

surface. It took 10 days (only 10 days!!) to collect all of the data! The data set covers all land areas between 

60°N and 56°S latitude (higher latitudes were excluded because of the inclination of the Shuttle orbit, 

which was 56°. The resolution of SRTM data is 30 m/pixel for the highest resolution data. The mission was 

flown in February of 2000, and one of the mission specialists, Janet Kavandi, was also on the mission that 

flew in July 2001 that flew the Hamilton College banner that's hanging in the Geo Department. 

 

Previewing the files for the Adirondacks 

• Go to ArcCatalog, and navigate to the Adk_Tutorial folder in your class Data folder on the 

server. Copy the folder to your C:/drive. Expand the Adk_Tutorial folder. In that folder, you'll see 

a number of items that contain data that we have available to add to the map that we'll make in 

ArcMap.  

• Open the Adk_Data folder inside the Adk_Tutorial folder. Preview the Adk_mosaic file. It has a 

familiar icon – you should recognize this by now as a raster image. In the Preview window, the 

DEM should look familiar! If you are familiar with New York State geography, you will 

recognize the dark-colored (low elevation) strips: the St. Lawrence River Valley to the northwest, 

Oneida Lake and the Mohawk River Valley to the south, and the Champlain and Hudson River 

Valleys to the east. Clinton is on this DEM, but it's hard to locate unless you're really familiar with 

the geography. 

• Most of the rest of the files in this folder are shape files. Preview roads, rivers, and faults. These 

are all line shape files. Preview the rock units shape files. These are polygon shape files. Preview 

the towns file. It's also a shape file, but the data are point data (hence the dots in the icon). 

• Shape files can consist of data as points, lines, or polygons, but an individual shape file cannot 

have more than one kind of shape data. So, the roads (lines) and towns (points) have to be in 

separate shape file. This is useful, because you might not want to have both on your map at the 

same time. 

• Go back to the Adk_Tutorial Folder, and preview the LF_orthoquad.tif file. This is like the 

Clinton orthoquad that you worked with in Part I of this tutorial. 

• Go back to the Adk_Tutorial Folder, and open the LF_ortho_phot folder. Preview 

LF_orthEUTM, and use the zoom tool to zoom in and look around a bit. It’s an aerial photograph, 

another type of raster image. 
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Making an ArcMap 

• Launch ArcMap, and open a new empty map. Before you save, make sure to check under File, 

Document Properties, Data Source Options to be sure that you are saving relative pathways. 

Save the map to your C:/drive. Remember! No spaces in the name! Short name!  

• Add the Spatial Analyst Extension, open and dock the toolbar for Spatial Analyst, if it is not 

visible (View, Toolbars, etc.). 

• Add the Adk_mosaic raster file.  

• Create a hillshade for the Adk_mosaic layer. Change the Z factor to 2 to  increase vertical 

exaggeration, and be sure to click on the folder next to <Temporary> to save the hillshade 

(otherwise, it will go away).  

 

Adding bedrock faults 

• Add the nyfaults.shp shape file. 

• Zoom out to show the entire map (click in the globe on the toolbar), and you'll see that the layer 

has faults mapped for the entire state. Zoom back in on the portion that has the bedrock geology 

(select a box with the magnifier tool, or right click on the bedrock layer and select zoom to layer). 

• ArcMap assigned an arbitrary color to the faults, but you can change the color if you don't like it 

or it's hard to see. Right click on the line in the TOC below nyfaults, and choose whatever color 

you'd like better. You may want to zoom in to check your choice. You can also make this layer a 

bit transparent, if you want. 

• Zoom in on the Adirondack region, and pan around, looking at the faults and the topography as 

shown on the hillshade.  

 

What general correlation exists between features in the topography and the locations of 

faults in the bedrock in the Adirondacks?  

  

 

 

 

 

 

Offer and defend and explanation for the correlation. 
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Adding information about bedrock geology 

• Now we're going to have a look at the influence of bedrock type on topography. 

• Go to the rock_units folder, and add the marbles.shp and gneisses.shp shape files. Make them 

both 50% transparent. Then, change the colors for each. Right click on the color box for gneisses 

in the TOC, and choose cantaloupe (2nd row, 3rd from left). Change the color of marbles to light 

vert (3rd row from bottom, 5th from right). Save your work. 

• Before going on, answer the following background questions. These questions will help you 

think about the differences between marble and gneiss. 

 

Marble is a carbonate rock, the metamorphic version of limestone. Given what you know 

about limestone, what would you predict about the dominant mechanism of weathering of 

marble in a wet climate like ours? Explain. 

 

 

 

Given what you know about limestone and what you have predicted about weathering of 

marble, what would you predict about the relative resistance of weathering of marble and 

gneiss? Explain. 

 

 

 

 

• Add the zoombx1.shp shape file, and right click to change the fill to no fill and left click to 

change the outline to black. Zoom in to the box in the NW. You'll see that the bedrock geology is 

dominated by gneisses (peach) and marbles (green). 

• Turn off the gneisses layer so that you can see the topography clearly. Now, toggle the marble 

layer on and off, and look for correlations between the topography and where the bedrock is 

marble and where it is gneiss (in this area, virtually everything that isn't marble is gneiss). Zoom 

out and then zoom in to the box in the central Adirondacks. Turn on the both the gneisses and 

marbles layers to see where they are, then turn off gneisses and toggle the marbles on and off.  

 

What correlation exists between topographic features and the location of marble vs. gneiss in 

the bedrock of the Adirondacks? Is this consistent with what you predicted? Why? Explain. 
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• Hide the zoombox layer, and turn the gneisses layer back on again. 

• Add all of the remaining rock unit layers except bedrock.shp. Change colors, if you find that some 

look too much alike. Make each one partially transparent so that you can see the hillshade 

underneath. 

 

Determining scale 

• How big are things on this map? Right click on the word Layers at the top of the TOC, and 

choose Properties. Click the General tab, and change Display to Kilometers. Click OK. 

• Find the measure tool in the toolbar (looks like a ruler). Click at one end/side of what you want to 

measure on the map (center the cross), and drag to the other. Double click to end. The length in 

kilometers appears in the lower left of the screen.  

 

Adding towns 

• Add the towns shape file. A dot appears on your map for each town.  

• To find out the name of a town, you can select the Get Info tool in the toolbar (the blue circle with 

the "i" in it), and click on any town dot. Make sure that the towns layer is the one selected or you 

will get info on a shape in a different layer. When you click on a town, you'll see all the 

information in the data base for that feature. 

• You can also see the data behind what appears on the map. Right click on the towns layer, and 

select Open Attribute Table. Look at all of the information that's stored behind the scenes!!  

• Because the town names are in the attribute table, we can add the labels for the towns to the map. 

Navigate to properties for the towns layer, and click the Labels tab. Click Label Features in this 

layer. Make sure that Label all the features the same way is selected in the Method scrolling 

menu. Scroll the field next to Label Field, and you'll see all of the possibilities for labeling each 

town (the list represents all of the columns in the attribute table that you just looked at). You can 

label the dots in the towns layer with any one of these attributes , but we'll choose NAME. 

• Use the default font, size, and color, although you can change these later if you want. Click OK. 

Be sure to save! 

• Zoom in to a portion of the geologic map. If you don't like the symbol and symbol color for towns, 

you can change it easily. Left click on the town symbol in the TOC, and you'll see a menu where 

you can change symbol size, color, and shape. Play around, if you want. Click OK. 

• Remember that you can always hide a layer by clicking in the check box in the TOC. 

• Locate Lyons Falls. Remember on the field trip that we were wondering why the falls at Lyons 

Falls was there? Add the Black_R_dem_tif and hillshade it. You can also add the Port Leyden 

topo map, if you want (pleyd_topo.tif). Move layers around, and turn things off, if you need to in 

order to check your various layers. 
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Why are there falls at Lyons Falls? Explain, citing evidence from your ArcMap. 

 

 

 

 

 

Adding streams 

• Add the streams shape file. Change the colors so that streams are blue. Be sure to save! 

 

Locating the Hudson River 

• We could add all of the river names if we wanted to, just as we added names for the towns. But, 

this would make our map too messy. We could also find the Hudson by using the Get Info tool 

and clicking rivers in the area where we think the Hudson is until we find the right river. But, 

ArcMap makes it easy to find the Hudson. Basically, we'll ask ArcMap to find the Hudson for us 

and show us where it is. This is called querying the database. 

• Right click on the streams layer in the TOC, and choose Selection and then Make this the only 

selectable layer. In the main ArcMap menu at the top of the screen, go to Selection, and Select by 

Attributes. You've now told ArcMap that you want to search only the streams layer and that you 

want to search by some attribute (in this case, river name) that is stored in the database. 

• The Select by Attributes window is basically a database search engine that has a calculator-like 

interface where you ask ArcMap to search for values that meet specific criteria. 

• Click Only show selectable layers in this list, to limit your choices to what's stored in the streams 

database. Be sure that Method is set to Create new selection. 

• The scrollable box list, in alpha order, all of the attributes of streams that you can search the 

database for. You want to search by name, so scroll down to NAME, and double click on it to add 

it to the box below. 

• In order to find the Hudson River, we want to search the database for the line whose name is 

Hudson River, so click the = box to add an = sign after NAME, and then click the box Get 

Unique Values. Scroll down and double click on Hudson River. What you should now have in the 

box is the following: "NAME"='HudsonRiver'. If this isn't what you have, try again, following the 

instructions carefully. Click OK. 

• Zoom your map until you see a bright blue line, identifying the Hudson River. You can use the 

Get Info tool to check to see if it's right. 

• You can deselect the Hudson and return it to normal by going to Selection and choosing Clear 

Selected Features. You can always select it again, if you need to. 

• Be sure to save!! 

 

Finishing the bedrock geology and colorizing by rock type 

• If we want to see the full bedrock geology, we'll need to add a new layer and turn off a few. Start 

by turning off rivers and towns. Add the bedrock.shp file.  
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• In the TOC, move the bedrock layer so that it lies below streams, towns, and faults in the list, but 

above the individual rock units in the list. 

• Zoom all the way out by clicking on the globe in the navigation bar. Notice that, even though the 

geologic map and the DEM don't cover the same area, ArcMap knew where to put each and how 

to scale them because both files are appropriately georeferenced. 

• We can zoom in right to the bedrock layer by right clicking on bedrock in the TOC and selecting 

Zoom To Layer. That will fill the screen with just the bedrock layer. 

• The default setting is for ArcMap to assign a single, randomly-selected color to all of the polygons 

in this file, so the map is all one color. We'll now ask ArcMap to assign colors to various areas on 

the map based on their bedrock types as contained in the database. 

• Right click on the bedrock layer, and choose Properties. Click the Symbology tab. In the left hand 

column, select Categories. In the Value Field, scroll down and select Material (i.e., rock type). 

Now we need to add values for materials. 

• Below the white window, click Add All Values. By doing this, you have asked ArcMap to make a 

list of all of the polygons with different rock type attributes. ArcMap arbitrarily assigns a different 

color to each rock type, which is coded in the list  by abbreviations such as Cbk, Op, etc.  

• Before clicking OK, uncheck "All Other Values" at the very top of the list. Click OK. ArcMap 

redraws the geology layer with colors based on the type of rock represented by each polygon.  

• Let's change the color of the layer that shows the rock type anorthosite. Scroll down the list under 

the bedrock layer header, and locate the color box labeled "a" (for "anorthosite"). Right click in 

the color box, and select a bright yellow. ArcMap will redraw the geo map with bright yellow 

wherever there is anorthosite on the map. You can change colors of any of the other fields, if you 

want. 

• Turn on the zoombox1 layer, and zoom into the central Adirondacks box. Make sure that the 

gneisses and marbles layers are turned on as well. Toggle the bedrock layer off and on, and you'll 

see that the bedrock geology is more complicated than it first appeared. When I created the 

gneisses layer for you, I lumped several different types of gneisses together to simplify things. 

• You can collapse all of the color boxes in the TOC by clicking the minus (minimize box) next to 

the layer name. Save your work! 

 
Adding the Little Falls Orthoquad and Orthophotos 

• Click on the Globe in the toolbar to zoom out to full map view. 

• Add the Little Falls topographic quadrangle (LF_orthoquad), located one level up from the 

Adk_Data folder in the Adk_Tutorial folder. Right click on the bedrock layer and select zoom to 

layer. Remember that, once you've added this layer, you can change color boxes 1, 4-7, and 

9-12 to "No color", leaving color boxes 0, 2, and 8 the way they are (black for 0, red for 4, 

and blue for 2 and 8). If you mess up the colors, you can always add the orthoquad again. 

Remember that changing the colors in ArcMap doesn’t change the original file. 

• Add the two orthophotos, which are located in the LF_ortho_phot folder. Zoom in and look at 

them. 
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• Did the orthophotos register perfectly with the orthoquads? How about with the DEM? Remember 

that you can make layers partially transparent as well as drag them around in the TOC so that you 

can have them in the order that you want. 

 

Creating a swell-looking map in ArcMap 
 
Simple printout – just what you see on the map screen 

• Start by turning off the layers you don't want to have on your printout. ArcMap will print only the 

layers that are visible (i.e., that have check marks next to the layer names) 

• Then, zoom in or out to what you want to have on the printed page. ArcMap will print whatever 

shows in the map window.  
• From the main File menu, select Page and Print Set-up. Make sure that the paper size is set to 

Letter, and choose either Portrait or Landscape. Be sure that the box Scale Map Elements… at 

the bottom is checked. Click OK.  
• Under File, you can Preview the page, if you want. 
• When you are ready to print, select Print from either the Preview window or from the main File 

menu. 
• If you want to print in color, export your map as a jpeg or pdf (under the main File menu) (see 

page 6 for details), and insert it into a Word file or open it in Acrobat Reader. 

 
Map with north arrows, scale bars, etc. 

You can make a labeled map from any section of your document. Here's how. 

 

Selecting what will appear in Layout View 

• Whatever appears in the ArcMap window will be what you'll see in Layout view.  

• Zoom to the portion of the file that you want to show, or zoom all the way out to include the entire 

file in the view. 

 

Viewing the layout 

• Below the regular ArcMap window, you will see two icons, a globe icon and a page icon. The 

globe icon takes you to the regular global view where you add and modify layers in ArcMap. The 

page icon takes you to the Layout view. 

• Toggle back and forth to see the difference. 

• In Layout view, clicking on your map will bring up a Data Frame. The colored outline and boxes 

of the Data Frame must be visible any time you want to modify the Data Frame. 

 

Moving around in the layout view 

• If you use the regular zoom and pan tools in the layout view, you will change what appears 

in the Data Frame. Remember that only what appears in the data frame will print. 
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• If you want to zoom your layout view without changing what's in the Data Frame, you have to 

uses the layout Zoom and Pan tools in the layout menu bar (the ones with the little page icon under 

the Zoom and Pan icons). 

 

Setting the Page Set-up for your Layout View 

• Go to the File menu and select Page and Print Set-up. 

• In this dialog box, you can select a printer, page orientation (landscape or portrait), and paper size. 

Be sure to check the box labeled Scale Map elements proportionally to changes in Page Size 

(this is at the bottom of the dialog box). For your Nile map, select 11x17 paper size (at the very 

top of the list). And be sure to also click Use Printer Page Settings in the Map Page Size. 

• Click OK. 

 

Change the size and position of your Data Frame 

• Be sure that your data frame is selected. Clicking and dragging will move the data frame. 

• Clicking and dragging a side handle will make the data frame shorter/taller or wider/skinnier (e.,g., 

if you want to bring the border closer to the object inside the frame).. 

• Clicking and dragging a corner handle will scale both height and width of the frame and what is in 

the frame.  

 

Adding scale, north arrow, etc. to your Data Frame 

Any of the items that you add below can be removed by selecting them a hitting the delete key. Start by 

selecting the data frame in the layout view using the selection tool (black arrow) in the main toolbar. 

• Adding a neat line 

o From the Insert menu, select Neatline. Choose the kind of border you want, and click 

OK. 

 

• If you don't want to have either a neat line or a frame around the object. 

o Even if you don't add a neat line, the default setting will put a black frame around the 

data frame. If you don't want this, right click on Layers in the TOC, and select Frame. 

Under Border, scroll up to None. Click OK.  

 

• Adding a north arrow 

o From the Insert menu, select North arrow. Choose the kind of north arrow you want, 

and click OK. 

o The north arrow appears in your Data Frame. To move it around, click on it to highlight 

it, and move it or scale it by dragging the handles. 

o To modify your north arrow, double-click on it, and choose a new color or a new style. 

 

• Adding a title 
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o From the Insert menu, select Title.  

o The easiest way to add and modify a title is to click anywhere outside the title to deselect 

it, and then double-click on it to bring up the properties box.  

o Type your title into the text box. 

o To select fonts, sizes, and colors, go to the bottom of the main screen to make selections.. 

Clicking apply instead of OK lets you test out options. 

o When you're happy with what you have, click OK.   

o To move the title around, click on it to highlight it, and move it where you want it to be. 

 

• Adding a scale bar 

o Go to the Layer Properties, and select the General tab. Choose the display units that you 

want. Choose something practical, because this is what will appear on your scale bar. 

o From the Insert menu, select scale bar. Choose the kind of scale bar you want, and click 

OK. 

o The scale bar appears in your Data Frame. To move it around, click on it to highlight it, 

and move it or scale it by dragging the handles. 

o To modify your scale bar, double-click on it, and make new choices. 

 

• Adding a callout box 

o In the drawing menu, click on the down arrow next to the Text tool (the A). Select the 

callout box (looks like a cartoon caption). Click on the map layout and drag. Type your 

text into the textbox, and format it using the text formatting tools in the Drawing toolbar. 

o Hit Enter. 

o To move the end point, select the callout box, and click and drag the end point. Ditto for 

the box. 

o If you want to change the text in the box, double click on the text in the box, and enter the 

text in the dialog box. 

 

• Adding a text box (this kind of a box won't have a leader) 

o From the Insert menu, select Text. Again, it's easiest to click outside to deselect it and 

then double click to bring up the options box.  

o Text does not wrap in this option. You will have to add returns where you want them. 

o Type what you want in the text box, and use the bar at the bottom of the main window to 

make choices about text font, size, and color. Click OK. 

o The text appears in your Data Frame. To move it around, click on it to highlight it, and 

move it or scale it by dragging the handles. 

o To modify your text, double-click on it, and make new choices. 

 

• Adding a leader or a line with an arrow 
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o Find the Drawing icons at the bottom of the main window. Click on the line icon, and 

select the line tool. 

o Draw your line, and double-click to end the line. Double-click on the line to bring up the 

properties box, and, if you want an arrow, go to Change Symbol and scroll to the 

bottom. Click OK. 

 

• Adding the Hamilton GIS logo 

o If you want to add the Hamilton GIS logo to your map, from the Insert menu, select 

Insert Picture. Navigate to the main level of the Geosc103_Data folder, and find 

geoGIS.tif. Select it. 

o It's big, and you can modify its size by click on it and dragging the handles. 

 

Map with multiple windows (Data Frames) 

You can make a map with multiple windows that show zoomed-in portions of your main map, and you can 

even link the windows together!! Very fancy. Save often as you are doing this!! It's easy to do 

something that you will regret. 

 

Creating the base map 

• Zoom in to whatever you want to have on your main base map. 

• Switch to layout view. 

• Add scale bar, north arrow, neat line, title, key, whatever you want. 

 

Adding new windows (Data Frames) 

• The new windows are called Data Frames.  

• If you want to have a second data frame, go to the Insert menu, and select Data Frame. You'll 

see a new listing in the TOC, and you'll see that your new Data Frame doesn't have anything in it. 

Go to your TOC, and left click and hold on the title of the layer you want to have in the new data 

frame, and drag it and drop it in your new data frame. You can drag as many layers as you want 

from the original menu. If you select the magnifier or pan tools from the regular menu (not the 

layout menu), you can zoom in to what you want in the new data frame. Pretty cool!!! 

• Rename your new data frame with a descriptive name. 

 

Linking your new Data Frame to the original window 

• Right click on the original Layers in the TOC, and get the Data Frame Properties. Select the 

Extent Rectangles tab. Click on your original Layers in the Other  Data Frames, and click the 

right arrow to move it to the right hand list.  

o Click the Frame button, and choose the color and size of the framing rectangle. You can 

always change this if you don't like it. You can see what it looks like by clicking Apply 

before you OK everything.  
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o To connect your new frame to the extent rectangle with a leader, check the Show Leader 

box, and choose Leader Symbols. When you're happy, click OK. You should now have a 

rectangle on your original map window that is connect to  your new data frame. 

o If you move your new data frame, just click the refresh icon (next to the page layout 

icon), and the leader will re-draw. 

o If you don't like the frame or leader, just go back to the Properties again and change 

them. 

• If you use the regular zoom and pan tools (not the ones for the layout view), you'll see that the 

rectangle changes size and location as you pan and zoom. Extra cool!!! 

• You can add separate titles and neat lines for your new data frame. 

• You can add as many new data frames as you want and link them to the original window. Just 

remember that you need to go to Layer Properties for the original Layers to make the extent 

rectangle show up on the original window. If you add several, you'll see why it's so important to 

rename each one! 

 

Exporting your map 

o When you are happy with your map, go to the File menu, and select Export Map. Under Option, 

click the General tab, and set the resolution to 200 (the width and height should automatically set 

to 2200 x 3400 pixels if your page setup is for 11x17 paper.) 

o You can select either jpeg format or pdf. For best printing, select pdf format. Then, click the 

Format tab, and click in the box to Embed all document fonts. 

o Name your map file. Navigate to your own data folder, and click Save. 

  

 

 


